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[bookmark: _Toc432586514]Introduction 

While working with organizations that serve the homeless, such as soup kitchens, shelters, and food banks, my desire to help the homeless has continually grown throughout my life.  And as I’ve continued to learn and utilize Geographic Information Systems (GIS), I’ve often considered that this might be a technology that could benefit the homeless and those wanting to serve the homeless.  Therefore, in the winter of 2014, I began to approach organizations throughout Metro-Atlanta to determine what types of GIS applications or analysis might benefit them.  Over time, the most promising option that materialized pointed to the Pathways Community Network Institute (PCNI).  After discussing several options with PCNI, it was ultimately decided to use a GIS to visualize the data within in an HMIS (Homeless Management Information System).  


[bookmark: _Toc432586515]Pathways and HMIS

Pathways is a nonprofit organization that focuses on collaborative and efficient use of technology in order to respond to poverty and homelessness.  As described on their website, they empower human services providers to a) coordinate delivery of human services (housing, counseling, health care and financial aid, b) ensure the services are appropriate, and c) monitor the long term impact of these services through research (PCNI.org, n.d.)  This organization is one of the major providers for Homeless Management information Systems (HMIS) in Georgia.

HMIS is an information technology system used to collect client level data on homeless individuals and those at risk of homelessness (HudExchange, 2014a).  Agencies that receive specific federal funds for homeless services are required by Congress to use HMIS.  Although there are multiple HMIS providers across the country, all of these providers are required to support a specific data model for their implementations, which is shown in Figure 1.

One may ask, “Why was it important to work with Pathways?” After several discussions with one of the Pathways’ research team members, it was often said that they wanted some basic geographic visualizations of the HMIS data.  However, they had no staff members that were familiar with using a GIS to do so.  Partnering with Pathways would bring GIS visualization and analysis to an organization that had no previous expertise with the technology. Providing additional insight to the data, which was not previously seen in basic spreadsheet or statistical analyses, was also a desired goal.  We also wanted to provide these insights in a medium that could be understood by anyone.  An additional outcome of the project would be a compilation of step-by-step procedures for other organizations to follow that may wish to do the same for their own communities.  

[image: ]
Figure 1 - A snapshot of the complex HMIS data model

[bookmark: _Toc432586516]Related Studies and Publications

There are multiple studies that use GIS in order to analyze the problems associated with homelessness.  One such study, completed by Wong and Hillier, used GIS to examine patterns of service usage in relation to community based prevention and used it to identify ways to improve the targeting of prevention services (Wong, 2001).  Another study, by Loubert, focused on datasets of geocoded 911 calls and mobility patterns of individuals using GPS in order to find a suitable location for a permanent homeless shelter (Loubert, 2010).   Several other homelessness studies involving GIS were also researched, however, most of them did not directly involve data from an HMIS.

There are several publications that do specifically describe the use of HMIS data.  The first document researched, Making the Most of HMIS Data, is a publication from the US Department of Housing and Urban Development (HUD).  This document provides a significant amount of information pertaining to HMIS data analysis, including how to use HMIS to understand characteristics and service needs of the people, how to use HMIS to analyze how homeless people use services, and more (Department of Housing and Urban Development, 2005).  This publication could serve as a guidebook when researching and/or verifying methods of data preparation for the GIS analysis that will be used to answer questions posed by Pathways.  The second item is a HUD conference presentation, titled Using Geographic Information Systems (GIS) as a Tool for HMIS Decision Making (Olivia, 2006).  Although the majority of this document focuses on describing a GIS, there are a few examples of creating thematic maps with HMIS data as well as analyzing service locations.  

[bookmark: _Toc432586517]Project Phases

This project involved three main phases, each of which is described in more detail below.  Phase 1 involved data research and coordination, which included topics such as understanding the HMIS data model, discovering useful census datasets, and coordinating permissions and connections to the HMIS database.  The analysis phase (Phase 2), which consisted of the majority of the project work, involved an iterative approach for creating geographic answers to questions presented by the Pathways organization.  Phase 3 involved publishing selected Phase 2 results to an online source and creating an interactive Story Map that would be suitable to even those unfamiliar with GIS basics.

[bookmark: _Toc432586518]Phase 1 – Data Research and Coordination

[image: ]HMIS Data
Figure 2 reveals the multiple components of Phase 1 that involved data research and coordination.   One of the first steps was to research HMIS in order to better understand the data and structure.  There were several publications describing the required HMIS schema such as the data model seen in Figure 1.  Another such publication was the HMIS data dictionary.  As described by HUD, the data dictionary is designed for vendors and agencies to understand all of the required elements in an HMIS system (HudExchange, 2014b).  Although there are numerous elements required in the data model, there were a few basic ones that were the focus of this analysis.  Those included items such as race, ethnicity, gender, veteran status, housing status, income, and zip code of last permanent address.   The zip code entry was used as the primary link that enabled a connection between the HMIS records and a geographic location.  
There are generally two primary methods in obtaining HMIS information.  The first is through pre-configured reports that are required by HUD for HMIS agencies to execute on a regular basis.  These are typically generated through an interactive web site and require special logins for each participating agency.  The other method is through a direct database connection.  This method allows users to pull ANY data from all of the tables using custom Structured Query Language (SQL) statements.  Custom SQL queries provide the most flexibility in obtaining the data but also require special access permissions from the HMIS provider.  In addition, the analyst using SQL is required to have significant knowledge of the HMIS schema as well as a solid understanding of SQL.  This project focused extensively on using custom scripts and queries as there was particular interest in obtaining information about client services that did not have corresponding web reports.Figure 2: Phase 1 - Data Research and Coordination



Census Data
Another important data source for this project was the US Census Bureau (USCB).  In addition to the decennial census results, the USCB also conducts annual surveys (referred to as the American Community Survey – ACS) in order to provide more timely estimates of data for the US population.    These surveys contain a vast number of characteristics (demographic, economic, social, financial, and housing) at a variety of geographic levels.  Figure 3 shows the different geographic levels used in ACS surveys.  
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Figure 3 - Census geographic entities and their relationships
US Census Bureau, American Factfinder, https://www.census.gov/geo/reference/hierarchy.html

This project used some of these USCB datasets (such as household information, median income, housing statistics, etc.) in conjunction with the HMIS data in order to perform additional mapping and analysis.  In order to do so, the census and HMIS data needed to be joined at the appropriate geographic levels.  Because the HMIS data only records most information at the zip code level, we were constrained to using census data at the same geographic level.  In addition, because the more common census data boundaries (such as tracts, block groups, blocks, etc.) do not align at all with zip code boundaries, they were not useful in this study without making significant and possibly errant assumptions.
It was learned that there is a geographic entity used in census data that does very closely align with zip code boundaries, which is referred to as a Zip Code Tabulation Area (ZCTA).  ZCTAs are generalized areal representations of the United States Postal Service zip codes, but are not exactly the same as ZIP codes.  The US Postal Service often realigns zip codes to meet changing needs.  These changes are not always reflected in the US Census ZCTA regions.  However, they are most often the best representation of zip codes for Census data.  Figure 4 below compares the actual zip code boundaries to ZCTA regions for DeKalb, Fulton, and Gwinnet counties of Georgia.   As described by the US Census Bureau, along with a thorough description of how they are formed, in most instances the ZCTA is the same as the Zip Code for an area (Census.gov, 2015a). County boundaries don’t always align nicely with ZCTA boundaries, but do for the majority of them (Figure 4.).
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Figure 4 - ZCTA vs Zip Code Boundaries
Accounts and HMIS Access
The last components of Phase 1 involved taking the required training modules to acquire access to HMIS data, obtaining permission and establishing access to a direct ODBC (Open Database Connectivity) connection to the HMIS database, and signing the appropriate confidentiality agreements.  Once those steps were completed, Phase 2 (Analysis) began.  
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This phase involved the geographic analysis of questions that were presented by the Pathways Organization.  Initial discussions with Pathways about GIS led to several preliminary questions that were as follows:

· What areas have the highest concentrations of clients?
· What types of clients are from which areas?
· What types of services do clients use most?
· Can we determine distances that clients have to services?

Figure 5 shows the workflow that was used in this phase.  After the initial questions were presented, data was acquired from the appropriate sources (HMIS or USCB) for the analysis.  Several variations of maps were then created in an attempt to answer the questions geographically.  After creating the results, feedback from peers was solicited for both validation and suggestions.  Afterwards, the results were presented to Pathways in the form of static maps that were hosted in an online workbook within Microsoft OneNote. Often times, these results led to additional questions or a desire to focus on a different geographic dataset (such as another county, or a CoC-continuum of care).  As shown in the workflow of Figure 5, these questions then began another iteration of the analysis phase.   After numerous iterations, some of those results were then taken forward to Phase 3 for a refined presentation to multiple audiences.Figure 5: Phase 2 - Analysis


This type of a workflow represented an agile approach that could a) handle multiple feedback requests from the ‘customer’, b) was not locked in to a specific analysis method, and c) involved constant communication from the ‘customer’.  
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Figure 6 - Proportional symbols showing client totals per zip code
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Figure 7 - Thematic map showing client proportions per zip code
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Figure 8 - Pie chart symbols showing race proportions per zip code
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Figure 9 - Drive time polygons from centers providing clothing services


The figures above were created using surrogate data and represent a very small sample of maps that could be used to answer some of the initial questions from Pathways.   Figure 6 contains a map using proportional symbols to reveal total counts of clients from each zip code region.  Figure 7 contains a thematic map that might be used to show client proportions from each zip code.  These proportions were produce by dividing the total number of clients from each zip code by the total population for each zip code (from the USCB ACS estimates).  Figure 8 shows a map using pie chart symbols to represent race proportions of the clients in each zip code.  Figure 9 contains a map representing travel times to specific service centers by using drive time polygons around each of the centers.  
There are thousands of variations of maps that could be produced to answer just the initial questions posed by Pathways.  This is why it was important to have an iterative approach so that the analysis could focus in on the results, themes, colors, etc. that best reveal answers to the customer’s proposed questions.  
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After multiple iterations of Phase 2, it was anticipated that results would not only be useful to the Pathways research team, but potentially to political decision makers as well.  It was a goal of this project to provide these results in a form that can be understood by anyone, especially decision makers.  In fact, the targeted audience in such cases was for users who have no background in GIS.  The ESRI Story Maps technology was chosen to meet these objectives.  Story Maps is a web-based technology on the ESRI platform that combines interactive maps and multimedia into rich, interactive experiences (Storymaps.argis.com, n.d.)  They enabled this project to tell the story of the GIS results in a manner that could be easily navigated by anyone, on any device (PC, tablet, mobile, etc.).  Transforming the results from this study into a user-friendly interface, enabled the widest audience to benefit from the geographical analysis of the HMIS data.  This also showcased, to a broader HMIS user base, how GIS can be used to better understand HMIS data in their own communities.  

Figure 10 shows the workflow that was used in the presentation phase (Phase 3) of this project.  After numerous iterations in Phase 2, Pathways decided to choose an analysis for the Cobb County CoC (Continuum of Care) to work with in Phase 3. A basic story was created and then implemented using the Story Map technology.  Several iterations were executed before the final product was passed along to the Cobb County CoC.   
The final step in this phase was to create a list of step-by-step procedures that other organizations, communities, and individuals could follow in order to visualize their own HMIS data within a GIS.  These procedures can be found in the appendices to this report. Figure 10: Phase 3 - Presentation



[bookmark: _Toc432586521]Results 

Due to the potentially sensitive nature of homeless numbers in a Continuum of Care, this section will focus entirely on the methods and products that were used to present the final results instead of the actual homeless numbers.  Such products include a Microsoft Access database for querying the HMIS database, a collection of static maps stored in a shared Microsoft OneNote, an online ‘Story Map’ written to introduce and explain one of the resulting studies, an online web application for further exploration of the data, and several procedural instruction sets for preparing and using HMIS data for a GIS.
Although not the original intention of the project, a significantly large effort was focused on pulling the necessary data from a direct connection to the backend HMIS database. Normally, pre-formatted web reports are used to access this data as well as produce reports that are required by the government.  Pathways requested that this project use a direct connection to the HMIS, as they desired to pull service data that did not have corresponding web reports.  Therefore, Microsoft Access was used to consume an ODBC connection to the HMIS data in order to obtain any information that we desired.  Ultimately, there were about 7 to 8 iterations of modifying a Microsoft Access ‘front-end’ database that was used to query data for both HMIS clients AND service data.  Custom queries and scripts were written to obtain the necessary data.  The resulting database, along with a step-by-step workflow, provides Pathways with a front-end system that can be used to pull the necessary data as desired by the analysts. 
As described earlier, a multitude of thematic maps were created for various geographic areas throughout the analysis phase.  The maps focused on a variety of topics, such as client totals, homeless client totals, ‘at risk’ client totals, veteran rates, child rates, agency drive times,  clients vs. poverty level, service totals, and more.  The maps also targeted different areas of interest as the project progressed, such as DeKalb County, the State of GA, the Atlanta CoC, and the Cobb County CoC.  A collection of static images of each of these maps was then placed within a Microsoft OneNote Notebook, which was organized by target analysis areas.  The notebook was shared amongst team members using Microsoft OneDrive.  Having a shared Notebook provided a central repository of the items and analysis that were discussed during weekly meetings.
Midway through the duration of the analysis phase, the project began to use online maps and web applications to host and display the results of specific analysis.  Obtaining ESRI ArcGIS Organizational Accounts through Penn State University allowed this project to provide the results in a password protected manner.  The online interaction was so well received, that this became the sole method of hosting results for our last area of focus, the Cobb County CoC.  Again, an online map was created for the Cobb County CoC as well as a web application that was created using ESRI’s Web App Builder that would allow users to perform several types of GIS analysis by using a simple web browser.  In addition to basic pop-up, pan and zoom features, other capabilities such as swipe analysis, custom charts, and custom geographical queries were also implemented.  
It was then decided to use the Cobb County CoC data to build an interactive story map for the presentation phase of this project.  The story map simply provides an introductory story to the Cobb County CoC data (PennStateGIS.Maps.ArcGIS.Com, 2015).  The story map walks users through some of the simple layers, as well as provides a few different swipe capabilities comparing layers (single clients vs family clients, and total clients vs median income).  Additionally, a single agency is showcased by showing their accessibility to Cobb County clients using drive time intervals of 5, 10, 15, and 20 minutes.  The final slide of the story map introduces the user to the web application described earlier and provides a link to access the application.  
That last product of this study resulted in a guidebook of instructions (see Appendices) that will be useful to both Pathways and other organizations that desire to map HMIS data in a GIS.  Four major topics are covered by these documents.  The first topic describes the steps to use the Microsoft Access Database to pull HMIS information for GIS analysis using the custom built database (this topic is primarily for Pathways).  The next topic demonstrated how to take raw HMIS data from a tabular dataset (such as a comma separate file - .CSV) and aggregate the data to the zip code level using Excel Spreadsheet Pivot Tables.  The next topic focused on importing this aggregated data, along with census data shapefiles, and joining the two datasets in order to produce thematic map visualization of the HMIS data within a desktop GIS (ArcMap).  The last topic focused on taking the aggregatated data and using ESRI Maps for Office and ArcGIS Online to create an online map for the basis of one’s own story map and web application.   The last three topics were shared publically to other agencies and organizations at a presentation of this study at the National Human Services Data Consortium Conference in Miami, FL in October 2015.  
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A variety of lessons were learned throughout the duration of this project.  These included matters such as the suitability of the ODBC data source and usefulness of other data sources, the need for frequent interactions between Pathways and the GIS analyst, the usefulness and capabilities that the online GIS capability introduced, as well as the change in the meaning of the results when focused on ‘at risk’ clients instead of ‘homeless’ clients. 
As mentioned before, Pathways desired the use of an ODBC connection in order to have more flexibility accessing data within the HMIS.  Although this ultimately did provide more flexibility with the data, it also slowed progress into the actual GIS analysis.  Additionally, during the earlier phases of the project, Pathways experienced some turnover with personnel that were most familiar with the HMIS database.  Although another data researcher was ultimately hired to remedy this, it did slow the progress of the project due to transfer of knowledge to both the new researcher, as well as myself.   I believe having access to the standard web reports would have been highly beneficial to mitigate these circumstances.  Additionally, a lot of the time spent around the direct database connection (including query and script development) could have been more focused on GIS aspects, including topics such as geo-statistical analysis.  The web reports would have also likely provided more insight into what other agencies and communities are more likely to experience, compared to the ODBC that this project was using.   Ultimately, the ODBC did provide an excellent path to the HMIS data, especially when the proper understanding of the schema and content was obtained.  However, I believe using this connection as the sole data source did significantly slow the progress of the project.  
Throughout this project, all parties involved attempted to meet on a weekly basis.  This frequency worked quite well, especially when all parties were consistently available.  These meetings were crucial in gathering feedback for direction on the GIS analysis.   However, due to a variety of normal life circumstances (conflicting schedules, illnesses, technology issues, etc.), the weekly frequency was not always met.  Therefore an alternative means of communication (email, phone, etc.) was sometimes necessary and sometimes proved difficult and occasionally slowed the progress of the project.  Having a ‘backup’ meeting scheduled for every week could have proved beneficial when circumstances prevented key members (including myself) from attending the primary meeting.   This ‘backup’ meeting could have easily been cancelled if not necessary.  Overall, the scheduled weekly interactions were extremely beneficial, which is the primary reason to suggest a planned backup meeting if needed.
Another lesson learned was the value of the online GIS capability.  During the first half of the project, the majority of the results were placed as static images within a Shared OneNote notebook.  During the second half of the project, the results were hosted in online maps.  Once these results were placed in the online environment, which allowed Pathways to have more data interaction, the feedback and optimism from Pathways staff around GIS seemed to accelerate.  As a GIS analyst who does have constant interaction with the data, it is easy to forget that static maps provide no interaction to end- users.  This lack of interaction can sometimes tend to hide the apparent value of using GIS to those who are unfamiliar with it.  The online options (web maps and story maps) are significant and bring many of the GIS capabilities to an audience unfamiliar with GIS.  I would highly recommend the use of an online, interactive GIS for ANY project that is trying to introduce the value of using a GIS.
The last major lesson learned was the change in meaning of the results when viewing ‘at risk’ client data vs. ‘homeless’ client data. Because the geographical component relied heavily on the ‘LastKnownPermanentZip’ column, this value meant something different between the two datasets.  ‘At risk’ clients are defined as those who are at risk of homelessness, but do currently have housing.  Therefore, the ‘LastKnownPermanentZip’ field for these users represents their current residence. The ‘LastKnownPermanentZip’ field for homeless clients represents their last residence before going homeless.  The resulting homeless client maps can be misleading as it may cause one to believe that those maps represent the CURRENT location of homeless clients.  In reality, they represent their last permanent address before going homeless.  As long as it was clear what was depicted for each type of client, using a GIS was beneficial for understanding all client types.  
[bookmark: _Toc432586523]Conclusion
It is my hope that this project, providing a geographic look at HMIS data, did provide significant, additional insight to HMIS data and that any outcome will ultimately lead to better serving the homeless community.   I also hope that the resulting step-by-step procedures produced will be useful to other organizations so that they may benefit from these methodologies and learn more about their local communities through use of a GIS.
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Appendix A - Pathways MS Access DB Steps Tutorial
(Including General Notes)

This tutorial shows the appropriate steps to configure and use a Microsoft Access Database to access client and service data in the Pathways HMIS.  This process was used by a GIS analyst to pull data from Pathways HMIS in order to ultimately map the data in a GIS.  The database was not intended as a final product with an easy to use GUI (which would take considerable time to develop).  However, these instructions were written to allow Pathways to continue to utilize the database in order to pull data from their HMIS OR develop similar queries for their dashboard which can pull analogous data for use in a GIS.  

Once steps 1-6 are completed, the database will allow users to query the Pathways HMIS database by both year and CoC (Community of Care) and save that data to a file that can then be processed by a GIS.  It assumes that an ODBC connection has already been created using another tutorial provided by Pathways.  Steps 1-6 only need to be executed when it is desired to refresh the data (i.e. quarterly, semi-annually, annually, etc.).  Step 7 is the one that can/should be repeated in order to query client and service information for various CoCs and years.  

At the very end of this tutorial are basic notes describing the main queries and scripts that are used to pull the HMIS data. 

Prerequisites:
· Microsoft Access (2010 or higher)
· ODBC connection to Pathways HMIS DB as created in the “Oracle ODBC Driver Installation and ODBC Connection Setup” tutorial document from Pathways

Pathways MS Access DB Steps Overview
1. Connect to and download proper HMIS tables using ODBC connection
2. Correct improper field types from ODBC conversion
3. Create appropriate indices to speed up queries
4. Link the ‘working’ MS Access DB to the ‘data’ MS Access DB
5. Create client table in ‘working’ DB
6. Populate client table from scripts
7. Run appropriate queries to pull the desired HMIS

Pathways MS Access DB Steps Details

1. Connect to and download proper HMIS tables using ODBC connection

a. Open up the ‘working’ MS Access database file by double clicking it in windows explorer.  The name will be similar to PathwaysReportsGAData_V10.accdb
b. Click External Data Tab in Ribbon
c. Click the ODBC Database button
d. Click Link to the data source
e. Click the Machine Data Source Tab 
f. Select the ODBC data source name created from the Oracle ODBC Driver and click OK
[image: ]

g. Enter the appropriate password for the ODBC connection and click OK.
h. Within the Link Tables window that opens, select the tables shown below.

[image: ]


i. Click OK
j. If the following windows open, select the appropriate unique identifier as shown in the windows below

[image: ]
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NOTE: We have just established a LINK to the tables, but now we are actually going to download the data locally for several reasons.  Primarily, performing many of the final queries and scripts, ESPECIALLY debugging them, takes WAY too long to perform over a network connection.  Therefore, the queries work MUCH better when the data is local.  Also, we don’t download them all at once due to timeout problems that will occur when downloading this large amount of data.  Following the steps below should prevent the timeout from occurring.  When finished, we will have close to 2GB of local data, which is the limit of Microsoft Access.  It maybe doable to convert the primary queries to work using linked tables (vs local tables) instead, but doing so for the GIS project was too problematic and WAY TOO time consuming to even perform a simple query.  

k. Highlight all of the previously linked tables EXCEPT for the GEORGIA_CLIENT_SERVICES_INFO table and the GEORGIA_CLIENT_STATUS_INFORMATION as shown below
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l. Right-click the selections and click ‘Convert to Local Table’. Enter the ODBC password again if necessary
m. Select the Database Tools tab in the main Access Ribbon and click the Compact and Repair Database button
n. Close the Access Database and reopen it
o. Right click GEORGIA_CLIENT_SERVICES_INFO table and select Convert to Local Table
p. Re-enter the ODBC connection password if prompted
NOTE: this step could take CONSIDERABLE time (30+ min)
q. Select the Database Tools tab and click the Compact and Repair Database button
r. Close the Access Database and reopen it
s. Under the ‘Queries’ list, double click the make table query ‘qry_make_georgia_client_status_info_table’

NOTE: This step was needed because the normal ‘Convert to local table’ process would not work with this table due to an ODBC error conversion method when dealing with the date field.  Therefore this workaround process was created.

t. When the query has completed, delete the table link ‘GEORGIA_CLIENT_STATUS_INFORMATION’
u. Then rename the table ‘GEORGIA_CLIENT_STATUS_INFORMATION_MAKE’ to ‘GEORGIA_CLIENT_STATUS_INFORMATION’

2. Correct improper field types from ODBC conversion

NOTE: I am not sure if the ODBC conversion is the issue, or the field types in the main DB themselves are the problem, but this step is needed to ensure that the key fields, which are used to match tables within a query, are of the same type.  Otherwise the queries will not join the tables properly (at least without major headache).  

a. Run code to enable large DB updates
i. Double click the module named ‘moduleSetLocksModForLargeUpdate’
ii. In the Code window that opens up, find the sub-routine titled ‘LargeUpdate()’ and click once anywhere within the code
iii. Click the green arrow (play) in the toolbar as shown below
[image: ]
iv. Close the code window

b. Change field types in GEORGIA_CLIENT_INFORMATION table
i. Right click the table GEORGIA_CLIENT_INFORMATION and click Design View
ii. Click in the Race_Code column data type field that says Number
iii. Select the drop down arrow and change it to Short Text
iv. Click in the CLIENT_KEY column data type field that says Short Text
v. Select the drop down arrow and change it to Number
vi. Your field types should appear as below
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vii. Click the Save button in the main toolbar of Microsoft Access as shown below
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viii. Click Yes at the warning that states Some data may be lost

c. Change field types in the HOUSING_STATUS_CODES table

i. Right click the table HOUSING_STATUS_CODES and click Design View
ii. Click in the CODE_KEY column data type that says Short Text
iii. Select the drop down arrow and change it to Number
iv. Then in the Field Size area at the bottom of the window, select Double as shown below
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v. Click the Save button in the main toolbar of Microsoft Access
vi. Click Yes at the warning that states Some data may be lost

d. Select the Database Tools tab and click the Compact and Repair Database button
e. Change the CLIENT_KEY field type to Double for the GEORGIA_CLIENT_SERVICES_INFO table
NOTE: Because this particular table contains so many records, we can’t simply change the data type.  We have to create a new field, run a query to copy and convert the CLIENT_KEY entries into the new field, and then remove the old field. 

i. Right click the table GEORGIA_CLIENT_SERVICES_INFO and click Design View
ii. Click in the first blank row and type CLIENT_KEY2 and set the type to number and the field size to Double (as seen previously)
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iii. Save the table and close it
iv. Double click the query named ‘qry_update_CLIENT_SERVICES_INFO_CLIENTKEY_FIELD’
v. Click yes at the warning that states you are about to run an update query
vi. Click yes at the warning that states there isn’t enough disk space to undo the changes
vii. Click yes when it states you are about to update X number of rows
viii. When the query has completed, Right click the table GEORGIA_CLIENT_SERVICES_INFO and click Design View
ix. Right click the row with the original CLIENT_KEY field and select Delete Rows
x. Click yes at the warning that states you are about to permanently delete the selected fields
xi. Rename the CLIENT_KEY2 Field to CLIENT_KEY
xii. Save the table

f. Select the Database Tools tab and click the Compact and Repair Database button

3. Create appropriate indices to speed up queries

a. Create appropriate indices on the GEORGIA_CLIENT_SERVICES_INFO table
i. Right click the table GEORGIA_CLIENT_SERVICES_INFO and click Design View
ii. Ensure the Design tab is selected in the main Access Ribbon and click the Indexes button
[image: ]

iii. Fill out the resulting table as shown below (the index name is not important)
[image: ]
iv. Close the table
v. Click the Save button in the main Access toolbar

b. Repeat the steps above for the GEORGIA_CLIENT_STATUS_INFORMATION table

[image: ]
c. Repeat the steps above for the GEORGIA_PROGRAM_ENROLLMENT table to set the indices on the table as shown below

[image: ]

d. Repeat the steps above for the GEORGIA_PROGRAM_PROFILE_INFO table to set the indices on the table as shown below

[image: ]

e. Close the current database

4. Link the ‘working’ MS Access DB to the ‘data’ MS Access DB

NOTE: This step links two MS Access DBs together.  It was necessary to split them into 2 (a data file, and a working file) because the local download of all the records was approaching the 2GB limit that MS Access has.  This would have prevented many large queries from running.

a. Open up the ‘working’ MS Access database file by double clicking it in windows explorer.  The name will be similar to PathwaysReportsGAWorking_V10.accdb
b. Click the ‘Enable Content’ if the warning appears about enabling content
c. Click the External Data tab of the MS Access Ribbon
d. Click the Linked Table Manager button
[image: ]
e. Click the Select All button on the newly opened window
f. Click the OK
g. Browse to the location of the current ‘data’ file and select it.  The name will be similar to PathwaysReportsGAData_V10.accdb and click Open
h. You should receive a window that say all selected tables were successful refreshed
i. Ensure that ALL tables are linked to the same MS Access db selected above
j. Click Close

5. Create client table in ‘working’ DB

a. Run code to enable large DB updates
i. Double click the module named ‘moduleSetLocksModForLargeUpdate’
ii. In the Code window that opens up, find the sub-routine titled ‘LargeUpdate()’ and click once anywhere within the code
iii. Click the green arrow (play) in the toolbar as shown below
[image: ]
iv. Close the code window

b. Create table
i. Double click the query named qry_Make_Georgia_Client_Expanded_Information
ii. Click yes at the warning that you are running a make table query
iii. Click yes when prompted that you are about to create x number of rows

c. Change field types
d. Right click the newly created table tb_CLIENT_INFORMATION_EXPANDED and click Design View
e. Change the following fields to the types listed below
[image: ]
f. Click the save icon in the main Access toolbar
g. Click yes at the warning that says some data may be lost
h. Close the table

6. Populate client table from scripts
a. Double click the module named ModuleGetZipsForEachClient
b. In the Code window that opens up, find the sub-routine titled ‘GetClientInfoZips ()’ and click once anywhere within the code
c. Click the green arrow (play) in the toolbar 
d. Enter the year number (i.e. 2015) for the current year you want the script to process data for
e. When finished, the script will display a message box

NOTE: this script will likely take 30+ minutes to run



7. Run appropriate queries to pull the desired HMIS

a. Run query to export client data to an Excel file
NOTE: This query will pull client information for a specific CoC utilizing a join between tables that matches clients to programs and programs to a CoC.  See the full explanation under the section General Database Information below.  

i. Right click the query named PROMPT_qry_Clients_in_Specific_COC_expanded_unique and select Export, Excel
ii. Choose a location and select OK
iii. Enter the desired CoC key that you wish to pull data for found in the table below

NOTE: you can find the same list by running the query qryShowDistinctCOCNames
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iv. Enter the desired year to pull data for
NOTE: Whatever year is entered must have already been processed using the custom script found in Step 6 (Populate client table from scripts)
v. A message will appear when your table has been exported
vi. Your output file is ready to process for a GIS (See Data Aggregation Tutorial)



b. Run two queries to export service data to an Excel file
NOTE: These two queries (both are needed) will pull service information for clients within specific CoC utilizing a join between tables that matches services to clients, clients to programs, and then programs to a CoC.  See the full explanation (including why two separate queries were needed) under the section General Database Information below.  

i. Right click the query named PROMPT_qry_ServicesPt1_from_Clients_in_Specific_COC_Comp_Prog and select Export, Excel
ii. Choose a location and select OK
iii. Enter the desired CoC key that you wish to pull data for (same as previous table) 
iv. Enter the desired year to pull data for
NOTE: Whatever year is entered must have already been processed using the custom script found in Step 6
v. A message will appear when your data has been exported
vi. Right click the query named PROMPT_qry_ServicesPt2_from_Clients_in_Specific_COC_Curr_Prog and select Export, Excel
vii. Choose a location and select OK
viii. Enter the same CoC key from step iii
ix. Enter the same year from step iv
x. A message will appear when your data has been exported
xi. Open both exported tables in Excel and append the export from pt2 to the export from pt 1 taking care that the columns are aligned correctly (they both have the same column names)
xii. Ensure that the column names row has been deleted from the appended data as the column names should already exist from the first export in row 1
xiii. Your output file is ready to process for a GIS (See Data Aggregation Tutorial)


General Database Information

NOTE: The appropriate 2016 fields have been added to the database since the documentation below was created.  

Client Information Table Created 

· Create custom table of client info -I run a basic query (see Fig 1) that creates a table of basic information for a client (including the matching race/vet/ethnicity descriptions).  The same query also creates additional fields:
Zip2012, Zip2013, Zip2014, Zip2015
HSC2012, HSC2013Desc, HSC2014Desc, HSC2015Desc
DisCond2012, DisCond2013, DisCond2014, DisCond2015
ChronHomeless2012, ChronHomeless2013, ChronHomeless2014, ChronHomeless2015
 
· Run Code to find Zips (and other misc items) - I run a script that follows the basic pseudo code to find information for each client:
· Prompt user for current year to process (i.e. 2015)
· Loop through every record in the client table created above
· Create a query to pull all status records for that year and client from the CLIENT_STATUS_INFORMATION table and sort it by the entry date (so the first entry of the year is at the top)
· Grab the housing status information, disabling cond, and chron homeless info from the first record of that query and assign it to the appropriate fields in the client table created above
· If a zip code is present in that first record, I assign it to the appropriate field in the client record.
· If a zip code is not present, I execute another query in the status record for any status update prior to that year and grab the most recent zip code up to that year.  This step is essential as zip code info is critical to the mapping and not all status updates have zip codes, but usually there is usually a zip code found at some point in the past
· Note:  I have to run this code multiple times (once for each desired year) for multiple reasons
 
 
[image: Machine generated alternative text:
GEORGIA_CUENTJNFORM...
! qryOnlyActiveHouseholdlriformati...
*
‘ CLIENT_KEY
DATE_OF_BIRTH
DO B_TYPE
ETHNIarY_CODE
NAM E_FIRST
GENDER_CODE
ID_TYPE
NAME_LAST
NAME_MIDDLE
RACECODE
NAME_SUFFIX
UNACCOMPANIED CHILD
VETERAN_STATUS_CODE
CREATE_USER_KEY
CREATE_DATE
UPDATE_TIM ESTAM P
k
CODE_KEY
STATUS
DESCRIPTION
UPDATE_TIMESTAMP
GEORGIA_ETHNICITY_CODES
*
? CODE_KEY
STATUS
DESCRIPTION
UPDATE_TIMESTAMP
*
FirstOf HOUSEH OLD_KEY
CLIENT_KEY
FirstOf RELATIONS HIP_CO DE
GEORGIA_GENDER_CODES
*
? CODE_KEY
STATUS
GENDER
UPDATE_TIMESTAMP
G EO RGIA_RAC E_C
*
? CODEKEY
STATUS
DESCRIPTION
UPDATE_TIM ESTAMP
GEORGIA_VETERAN_CODES
-‘]
 
SELECT GEORGIA_CLIENT_INFORMATION.CLIENT_KEY, GEORGIA_CLIENT_INFORMATION.DATE_OF_BIRTH, DateDiff("yyyy",[DATE_OF_BIRTH],Date()) AS Age, GEORGIA_CLIENT_INFORMATION.UNACCOMPANIED_CHILD, GEORGIA_CLIENT_INFORMATION.ETHNICITY_CODE, GEORGIA_ETHNICITY_CODES.DESCRIPTION AS ETHNICITY, GEORGIA_CLIENT_INFORMATION.GENDER_CODE, GEORGIA_GENDER_CODES.GENDER, GEORGIA_CLIENT_INFORMATION.RACE_CODE, GEORGIA_RACE_CODES.DESCRIPTION AS RACE, GEORGIA_CLIENT_INFORMATION.VETERAN_STATUS_CODE, GEORGIA_VETERAN_CODES.DESCRIPTION AS VETERAN_STATUS, qryOnlyActiveHouseholdInformation.FirstOfHOUSEHOLD_KEY, qryOnlyActiveHouseholdInformation.FirstOfRELATIONSHIP_CODE, "" AS Zip2012, "" AS Zip2013, "" AS Zip2014, "" AS Zip2015, "" AS HSC2012Desc, "" AS HSC2013Desc, "" AS HSC2014Desc, "" AS HSC2015Desc, "" AS DisCond2012, "" AS DisCond2013, "" AS DisCond2014, "" AS DisCond2015, "" AS ChronHomeless2012, "" AS ChronHomeless2013, "" AS ChronHomeless2014, "" AS ChronHomeless2015 INTO tb_CLIENT_INFORMATION_EXPANDED
FROM ((((GEORGIA_CLIENT_INFORMATION LEFT JOIN GEORGIA_ETHNICITY_CODES ON GEORGIA_CLIENT_INFORMATION.ETHNICITY_CODE = GEORGIA_ETHNICITY_CODES.CODE_KEY) LEFT JOIN GEORGIA_VETERAN_CODES ON GEORGIA_CLIENT_INFORMATION.VETERAN_STATUS_CODE = GEORGIA_VETERAN_CODES.CODE_KEY) LEFT JOIN GEORGIA_GENDER_CODES ON GEORGIA_CLIENT_INFORMATION.GENDER_CODE = GEORGIA_GENDER_CODES.CODE_KEY) LEFT JOIN GEORGIA_RACE_CODES ON GEORGIA_CLIENT_INFORMATION.RACE_CODE = GEORGIA_RACE_CODES.CODE_KEY) LEFT JOIN qryOnlyActiveHouseholdInformation ON GEORGIA_CLIENT_INFORMATION.CLIENT_KEY = qryOnlyActiveHouseholdInformation.CLIENT_KEY
ORDER BY GEORGIA_CLIENT_INFORMATION.CLIENT_KEY;
 
 
Fig 1-Client 'make table' query structure and SQL
 
 
 
Query to pull clients for a specific CoC for a specific year
 
· Use a Prompt Query - I run a query that prompts the user for a CoC key (i.e. 6 = Cobb County) and also the desired year.  This will essentially grab all clients for that specific CoC in the year entered.  This query HAS to assume that any client for a CoC will have been entered into a program because programs can be linked to CoCs via the PROGRAM_PROFILE_INFO table.  Without this assumption, there was no way that I saw to link a CoC to a client.  The query also has the following characteristics:
3. Will only grab clients who have enrolled in programs that are registered for the entered CoC key
3. Will grab clients whose program entry dates are <= year entered AND program exit dates are >= year entered 
OR Will grab clients whose program entry dates<=year entered and exit dates = null (still in program)
. Will only return the first client record (using a group query) because otherwise the same client is returned multiple times if the client was entered into multiple programs simultaneously
 
[image: Machine generated alternative text:
C UENT INFORMATION EXPAND... GEORGIA PROGRAM ENROLLMENT GEORGIA P
* I * *
CLIENT_KEY CLIENT_KEY  PROGRAM_KEY
DATE_OF_BIRTH DESTINATION_CODE PROGRAM_NAME
Age ENTRY_CASH_KEY AGENCY_KEY
UNACCOMPANIED_CHILD PROGRAM_ENTRY_DATE AGENCY_NAME
EmNIarY_CODE ENTRY_NONCASH_KEY HMIS_PARTICIPANT
ETHNICITY EXIT_CASH_KEY MAX_STAY_DAYS
GENDER_CODE PROGRAM_EXIT_DATE PROGRAM_TYPE_CODE
GENDER EXIT_NONCASH_KEY PROGRAM_TYPE
RACE_CODE ‘ PROGRAM_ENROLLMENTKEY SITE_KEY
RACE AGENCY_KEY SITE_NAME
VETERAN_STATUS_CODE PROGRAM_KEY SITE_GEOCODE
VETERAN_STATUS REASON_LEAVING_KEY TARGET_POP_A_CODE
FirstOfHOUSEHOLD_KEY HOUSEHOLD_KEY TARGET_POP_A_NAME
FirstOf RELATIONSHIP_CODE UPDATE_TIM ESTAMP TARGET_POP_B_CODE
Zip2012 TARGET_POP_B_NAME
Zip2013 COC_KEY
Zip2014 COC_NAME
Zip2OlS MCKINNEY_VENTO
HSC2Ol2Desc CURRENT_BED_COUNT
HSC2O13Desc CURRENT_UNIT_COUNT
HSC2O14Desc UPDATE_TIMESTAMP
HSC2O15Desc
Dis Con d2012
Dis Con d2013
Dis Con d2014
Dis Con d201 5
ChronHomeless2Ol2
ChronHorneless2Ol3
Chron Horn eles s2014
ChronHorneless2ols]
 
SELECT tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY, First(tb_CLIENT_INFORMATION_EXPANDED.Age) AS FirstOfAge, First(tb_CLIENT_INFORMATION_EXPANDED.ETHNICITY) AS FirstOfETHNICITY, First(tb_CLIENT_INFORMATION_EXPANDED.GENDER) AS FirstOfGENDER, First(tb_CLIENT_INFORMATION_EXPANDED.RACE) AS FirstOfRACE, First(tb_CLIENT_INFORMATION_EXPANDED.VETERAN_STATUS) AS FirstOfVETERAN_STATUS, First(GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_ENTRY_DATE) AS FirstOfPROGRAM_ENTRY_DATE, First(GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_EXIT_DATE) AS FirstOfPROGRAM_EXIT_DATE, First(GEORGIA_PROGRAM_ENROLLMENT.AGENCY_KEY) AS FirstOfAGENCY_KEY, First(GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_KEY) AS FirstOfPROGRAM_KEY, First(GEORGIA_PROGRAM_PROFILE_INFO.PROGRAM_NAME) AS FirstOfPROGRAM_NAME, First(GEORGIA_PROGRAM_PROFILE_INFO.COC_NAME) AS FirstOfCOC_NAME, First(tb_CLIENT_INFORMATION_EXPANDED.Zip2012) AS FirstOfZip2012, First(tb_CLIENT_INFORMATION_EXPANDED.HSC2012Desc) AS FirstOfHSC2012Desc, First(tb_CLIENT_INFORMATION_EXPANDED.ChronHomeless2012) AS FirstOfChronHomeless2012, First(tb_CLIENT_INFORMATION_EXPANDED.DisCond2012) AS FirstOfDisCond2012, First(tb_CLIENT_INFORMATION_EXPANDED.Zip2013) AS FirstOfZip2013, First(tb_CLIENT_INFORMATION_EXPANDED.HSC2013Desc) AS FirstOfHSC2013Desc, First(tb_CLIENT_INFORMATION_EXPANDED.DisCond2013) AS FirstOfDisCond2013, First(tb_CLIENT_INFORMATION_EXPANDED.ChronHomeless2013) AS FirstOfChronHomeless2013, First(tb_CLIENT_INFORMATION_EXPANDED.Zip2014) AS FirstOfZip2014, First(tb_CLIENT_INFORMATION_EXPANDED.DisCond2014) AS FirstOfDisCond2014, First(tb_CLIENT_INFORMATION_EXPANDED.HSC2014Desc) AS FirstOfHSC2014Desc, First(tb_CLIENT_INFORMATION_EXPANDED.ChronHomeless2014) AS FirstOfChronHomeless2014, First(tb_CLIENT_INFORMATION_EXPANDED.Zip2015) AS FirstOfZip2015, First(tb_CLIENT_INFORMATION_EXPANDED.HSC2015Desc) AS FirstOfHSC2015Desc, First(tb_CLIENT_INFORMATION_EXPANDED.DisCond2015) AS FirstOfDisCond2015, First(tb_CLIENT_INFORMATION_EXPANDED.ChronHomeless2015) AS FirstOfChronHomeless2015, First(tb_CLIENT_INFORMATION_EXPANDED.FirstOfHOUSEHOLD_KEY) AS FirstOfFirstOfHOUSEHOLD_KEY, First(tb_CLIENT_INFORMATION_EXPANDED.FirstOfRELATIONSHIP_CODE) AS FirstOfFirstOfRELATIONSHIP_CODE
FROM (tb_CLIENT_INFORMATION_EXPANDED RIGHT JOIN GEORGIA_PROGRAM_ENROLLMENT ON tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY = GEORGIA_PROGRAM_ENROLLMENT.CLIENT_KEY) INNER JOIN GEORGIA_PROGRAM_PROFILE_INFO ON GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_KEY = GEORGIA_PROGRAM_PROFILE_INFO.PROGRAM_KEY
WHERE (((GEORGIA_PROGRAM_PROFILE_INFO.COC_KEY)=[Enter a CoC Key]) AND ((Year([PROGRAM_ENTRY_DATE]))<=[Enter a Year]) AND (([Enter a Year])<=(Year([PROGRAM_EXIT_DATE])))) OR (((GEORGIA_PROGRAM_PROFILE_INFO.COC_KEY)=[Enter a CoC Key]) AND ((Year([PROGRAM_ENTRY_DATE]))<=[Enter a Year]) AND ((GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_EXIT_DATE) Is Null))
GROUP BY tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY
ORDER BY tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY;
 
Fig 2 - Query for Clients in a CoC
 
 
 
Queries (pt1 and pt2) to pull services for clients in a specific CoC for a specific year
 
 
. Use two prompt queries.  -  I had to split this one into two queries (one for users in completed programs [where a program exit date exists] and one for current programs [where program exit date is null]).  If I tried to join the two conditions into one (such as the client query), it took way too long to run, so I split them into two and join the results in Excel.  The queries run very similar to the query above except that GEORGIA_CLIENT_SERVICES_INFO table is also joined in.  In addition, due to the nature of the query, it CAN return the same request more than once if a client is enrolled in two or more programs.  HOWEVER, the Pivot tables I use in Excel that perform a 'distinct count' eliminate the redundant records so it is not an issue in the GIS workflow.  A group query might eliminate this, but was problematic for me to create and what I had worked for my workflow.  The two queries (see Fig 3 and 4) have the properties below
 
. Prompt query 1 (services during completed programs)
6. Will only grab clients who have enrolled in programs that are registered for the entered CoC key
6. Will grab clients whose program entry dates are <= year entered and program exit dates are >= year entered 
6. Will only pull service records who's service date is between the program entry date and the program exit date of the current client, if and only if the service date is within the year entered into the prompt
 
. Prompt query 2 (services during current programs)
7. Will only grab clients who have enrolled in programs that are registered for the entered CoC key
7. Will grab clients whose program entry dates are <= year entered and program exit dates are null (still in program)
7. Will only pull service records who's service date is >= the program entry date and in the year entered into the prompt
 
 
[image: Machine generated alternative text:
tbC UENTJNFORMA11ONEXPA... GEORGIA_PROGRAMENROLLM ENT GEORGIA PROGRAM PROFILE...
* *
*
CLIENT_KEY CLIENT_KEY 9 PROGRAM_KEY
DATE_OF_BIRTH
ENTRY CASH KEY AGENCY_KEY
Age -
PROGRAM ENTRY DATE AGENCY_NAME
UNACCOMPANIED_CHILD
ENTRY NONCASH KEY HMIS PARTICIPANT
ETHNICITY_CODE
EXIT CASH KEY MAX_STAY_DAYS
DESTINATION CODE _]_ PROGRAM NAME
ETHNICITY
PROGRAM EXIT DATE PROGRAM_TYPE_CODE
GENDER_CODE
EXIT NONCASH KEY PROGRAM_TYPE
GENDER
9 PROGRAM ENROLLMENT KEY SITE_KEY
RACE_CODE
AGENCY KEY SUE_NAME
RACE
PROGRAM KEY SITE_GEOCODE
VETERAN_STATUS_CODE
REASON LEAVING KEY TARGET_POP_A_CODE
VETERAN_STATUS
HOUSEHOLD KEY TARGET_POP_A_NAME
FirstOfHOUSEHOLD_KEY
UPDATE 1IMESTAMP TARGET_POP_B_CODE
FirstOfRELATIONSHIP_CODE
TARGET POP B NAME
Zip2012
__________________________ COC KEY
Zip2013
GEORGIA CUENT SERVICES INFO COC_NAME
Zip2014 ____________________________________
MCKINNEY VENTO
Zip2015 *
HSC2O12Desc 9 SERVICE_REC_KEY CURRENT_BED_COUNT
CURRENT UNIT COUNT
HSC2O13Desc NEED_CODE
HSC2O14Desc NEED_DESCRIPTION UPDATE_TIMESTAMP
HSC2O15Desc OUTCOME_KEY
DisCond2Ol2
DISBURS_AMT_ASKED
DisCond2Ol3
ChronHomeless2ol2 DISBURSEMENT_FLAG
DISBURS_AMT
DisCond2Ol4
UPDATE_DATE
DisCond2Ol5
UPDATE_USER_KEY
ChronHomeless2ol3 V SERVICE_DATE
UPDATE_TIMESTAMP
-i CLIENT_KEY]
 
SELECT tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY, GEORGIA_CLIENT_SERVICES_INFO.SERVICE_REC_KEY, tb_CLIENT_INFORMATION_EXPANDED.Zip2015, tb_CLIENT_INFORMATION_EXPANDED.HSC2015Desc, GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_ENTRY_DATE, GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_EXIT_DATE, GEORGIA_PROGRAM_ENROLLMENT.AGENCY_KEY, GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_KEY, GEORGIA_PROGRAM_PROFILE_INFO.PROGRAM_NAME, GEORGIA_PROGRAM_PROFILE_INFO.COC_NAME, GEORGIA_CLIENT_SERVICES_INFO.NEED_CODE, Left([NEED_CODE],2) AS NeedCodePrefix, GEORGIA_CLIENT_SERVICES_INFO.NEED_DESCRIPTION, GEORGIA_PROGRAM_PROFILE_INFO.COC_KEY, GEORGIA_CLIENT_SERVICES_INFO.SERVICE_DATE, [tb_CLIENT_INFORMATION_EXPANDED].[CLIENT_KEY] & [GEORGIA_CLIENT_SERVICES_INFO].[SERVICE_REC_KEY] AS ClientServiceKey, [tb_CLIENT_INFORMATION_EXPANDED].[CLIENT_KEY] & NeedCodePrefix AS ClientNeedCodePrefixKey
FROM ((tb_CLIENT_INFORMATION_EXPANDED RIGHT JOIN GEORGIA_PROGRAM_ENROLLMENT ON tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY = GEORGIA_PROGRAM_ENROLLMENT.CLIENT_KEY) INNER JOIN GEORGIA_PROGRAM_PROFILE_INFO ON GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_KEY = GEORGIA_PROGRAM_PROFILE_INFO.PROGRAM_KEY) LEFT JOIN GEORGIA_CLIENT_SERVICES_INFO ON tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY = GEORGIA_CLIENT_SERVICES_INFO.CLIENT_KEY
WHERE (((GEORGIA_PROGRAM_PROFILE_INFO.COC_KEY)=[Enter a CoC Key]) AND ((GEORGIA_CLIENT_SERVICES_INFO.SERVICE_DATE) Between [GEORGIA_PROGRAM_ENROLLMENT].[PROGRAM_ENTRY_DATE] And [GEORGIA_PROGRAM_ENROLLMENT].[PROGRAM_EXIT_DATE]) AND ((Year([PROGRAM_ENTRY_DATE]))<=[Enter a Year]) AND (([Enter a Year])<=(Year([PROGRAM_EXIT_DATE]))))
ORDER BY tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY;
 
Fig 3 - Query 1 for client services in a CoC (completed programs)
 
SELECT tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY, GEORGIA_CLIENT_SERVICES_INFO.SERVICE_REC_KEY, tb_CLIENT_INFORMATION_EXPANDED.Zip2015, tb_CLIENT_INFORMATION_EXPANDED.HSC2015Desc, GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_ENTRY_DATE, GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_EXIT_DATE, GEORGIA_PROGRAM_ENROLLMENT.AGENCY_KEY, GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_KEY, GEORGIA_PROGRAM_PROFILE_INFO.PROGRAM_NAME, GEORGIA_PROGRAM_PROFILE_INFO.COC_NAME, GEORGIA_CLIENT_SERVICES_INFO.NEED_CODE, Left([NEED_CODE],2) AS NeedCodePrefix, GEORGIA_CLIENT_SERVICES_INFO.NEED_DESCRIPTION, GEORGIA_PROGRAM_PROFILE_INFO.COC_KEY, GEORGIA_CLIENT_SERVICES_INFO.SERVICE_DATE, [tb_CLIENT_INFORMATION_EXPANDED].[CLIENT_KEY] & [GEORGIA_CLIENT_SERVICES_INFO].[SERVICE_REC_KEY] AS ClientServiceKey, [tb_CLIENT_INFORMATION_EXPANDED].[CLIENT_KEY] & NeedCodePrefix AS ClientNeedCodePrefixKey
FROM ((tb_CLIENT_INFORMATION_EXPANDED RIGHT JOIN GEORGIA_PROGRAM_ENROLLMENT ON tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY = GEORGIA_PROGRAM_ENROLLMENT.CLIENT_KEY) INNER JOIN GEORGIA_PROGRAM_PROFILE_INFO ON GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_KEY = GEORGIA_PROGRAM_PROFILE_INFO.PROGRAM_KEY) LEFT JOIN GEORGIA_CLIENT_SERVICES_INFO ON tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY = GEORGIA_CLIENT_SERVICES_INFO.CLIENT_KEY
WHERE (((GEORGIA_PROGRAM_ENROLLMENT.PROGRAM_EXIT_DATE) Is Null) AND ((GEORGIA_PROGRAM_PROFILE_INFO.COC_KEY)=[Enter a CoC Key]) AND ((GEORGIA_CLIENT_SERVICES_INFO.SERVICE_DATE)>=[GEORGIA_PROGRAM_ENROLLMENT].[PROGRAM_ENTRY_DATE]) AND ((Year([PROGRAM_ENTRY_DATE]))<=[Enter a Year]))
ORDER BY tb_CLIENT_INFORMATION_EXPANDED.CLIENT_KEY;
 
Fig 4 - Query 2 for client services in a Coc (ongoing programs) .  Note the join structure is the same as Fig 3
 
 
		









[bookmark: _Toc432586526]Appendix B - Data Aggregation Workflow

This appendix shows the appropriate steps to take exported data from an HMIS and prepare it for visualization within a GIS.  

Prerequisites:
· Excel 2013 (to make use of the ‘Distinct Count’ Pivot Table feature, otherwise Excel 2010)
· HMIS Data containing a unique identifier for each client (such as CLIENT_KEY), a zip code field (such as LastKnownPermanentZip) and any other field of interest (Gender, Age, Vet Status, etc.)

Note: The following screenshots contain sample HMIS data with randomized age and client keys and do not represent actual data from the sample zip codes.  

Data Aggregation Steps Overview
1. Format the Exported HMIS Data Into an Excel Table
2. Create Pivot Table(s)
3. Prepare Final Table For GIS


Data Aggregation Steps Details
1. Format the Exported HMIS Data Into an Excel Table

a. Open the exported data from HMIS into excel.  It MUST contain a unique identifier for each client (such as CLIENT_KEY) AND the LastKnownPermanentZip field from the HMIS

[image: ]
b. Ensure the data begins in Column A, Row 1
c. Click on Column A, Row 1, then Select the Insert Tab of the Excel Ribbon and click the ‘Table’ Button
d. Ensure the correct range is listed in the input box (if not, correct it) and Click OK

[image: ]

e. OPTIONAL: If additional columns are desired (such as Age Group), follow the steps below to create calculated fields using Excel formulas

i. Right-click any column header (such as cell C1) and select Insert / Table Columns to the Left
ii. Click in the new column header and rename as appropriate (in this case: ‘AgeGroup’)
iii. Click in the row below the new header (Row 2) and enter the desired formula.  In this case, we will use the formula below which utilizes multiple if-then Excel formulas to assign an age grouping to each entry.  The formula is dependent on an existing column ‘Age’ which was previously calculated in a database query based off the birth date.  It is possible your data will contain a birth date column.  If so, you will need to create a calculated field called ‘Age’ based off the birth date field before the formula below can be used.
=IF([@Age]<18,"LT18",IF(AND([@Age]>=18,[@Age]<=24),"18-24",IF(AND([@Age]>=25,[@Age]<=34),"25-34",IF(AND([@Age]>=35,[@Age]<=44),"35-44",IF(AND([@Age]>=45,[@Age]<=54),"45-54",IF(AND([@Age]>=55,[@Age]<=64),"55-64",IF(AND([@Age]>=65,[@Age]<=74),"65-74","75+")))))))

2. Create Pivot Table(s)

a. Click on Column A, Row 1, then Select the Insert Tab of the Excel Ribbon and click the ‘Pivot Table’ Button
b. If your data contains repeating rows for any client, check the checkbox that says ‘Add this data to the Data Model’.  This will enable the filtering of distinct values during the Pivot table creation
c. Accept the remaining defaults and click OK
d. Under the top right section titled ‘PivotTable Fields’, drag the CLIENT_KEY field to the bottom right square titled ‘VALUES’
i. Click the down arrow next to the ‘Sum of CLIENT_KEY’ entry and select ‘Value Field Settings’
ii. Scroll to the bottom to select Distinct Count, and select OK.  Note that this will only count a unique client once if your data contains multiple entries for each clients.  This could occur when a Program Entry report is used that may contain multiple program entries for a single client.  If you did not select ‘Add to the Data Model’ in step b above, select Count instead
e. Under the top right section titled ‘PivotTable Fields’, drag the LastKnownPermanentZip field to the bottom left square titled ‘ROWS’
f. Under the top right section titled ‘PivotTable Fields’, drag a field of interest (in this case Veteran) to the bottom right square titled ‘Columns’
g. You now have an aggregated count of veterans for each zip code as well as a total count of clients for each zip code.  

[image: ]

h. You could create additional pivot tables focusing on another parameter (such as age group). Due to pivot table functionality, I have found this to be easier than trying to analyze multiple parameters within a single pivot table.  Multiple pivot tables could then be pasted together for your final table to be used in a GIS

3. Prepare Final Table For GIS

a. Copy the main table from the pivot table results and paste into a new tab as shown below by using the Paste Values Function  (Right-click the A1 cell in a new tab, select Paste Special, Select Paste Values)

[image: ]

b. Delete the first row starting with ‘Count of’ or ‘Distinct Count’ as well as the final row titled ‘Grand Total’ 
c. Change any row in Column A that says ‘blank’ to a 0 if it exists
d. Rename the first row header from ‘Row Labels’ to ‘ZipCode’
e. Rename all remaining columns to one word names
f. Click on Column A, Row 1, then Select the Insert Tab of the Excel Ribbon and click the ‘Table’ Button, and select OK on the resulting input box.  The results should appear similar to below
[image: ]

g. Change empty cells to Zero for better processing by a GIS.  A GIS may treat empty cells as a Null instead of a zero which may result in undesired results in formulas
i. Click in a blank cell inside the new table
ii. On the Home tab of the Excel Ribbon, click Find & Select, Go To Special
iii. Selection the ‘Blanks’ option and click OK

[image: ]
iv. Enter a 0 into the current cell, and hit CTRL-Enter at the same time
v. The remaining cells should fill with 0’s and appear as below

[image: ]
	
h. Rename the sheet name to something more appropriate, such as “GIS”
i. Rename the table name to something more appropriate, such as “GIS” using the Design tab in the Ribbon
j. Save the Excel File






[bookmark: _Toc432586527]Appendix C - Desktop GIS Workflow

This appendix shows the appropriate steps to take aggregated HMIS data and create visualizations within a Desktop GIS (ESRI’s ArcMap).  It will cover two unique variations, but there are literally thousands that could be created.

Prerequisites:
· Aggregated HMIS data at the zip code level
· ArcMap 10.0 or higher

Desktop GIS Steps Overview
1. Obtain the appropriate ZCTA (Zip Code Equivalent) Shapefile and Import into GIS
2. Join aggregated HMIS results with the ZCTA file within the GIS
3. Prepare appropriate visualizations


Desktop GIS Steps Details
1. Obtain the appropriate ZCTA (Zip Code Equivalent) Shapefile and Import into GIS

a. Open http://www.census.gov in any web browser
b. Click the Geography Header, then select ‘Maps and Data’
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c. Click ‘TIGER PRODUCTS’ in the left Margin
d. Click the link ‘TIGER/Line Shapefiles’
e. Click the year of interest [I will select 2014], Expand the ‘Download’ section and select ‘Web Interface’
[image: ]

f. Under the ‘Select a layer type’, highlight the item ‘Zip Code Tabulation Areas’ and click the ‘submit’ button
g. Click the ‘Download national file’ and save to a location on your computer.  Note this could take 10 minutes or more depending on your network speed
h. Unzip the downloaded file to the current directory
i. NOTE: You may also want to repeat steps f to h for the ‘States (and equivalent)’ layer type or any other layer for reference use in the GIS

2. Join aggregated HMIS results with ZCTA file within the GIS

a. Create a map document

i. Open Arcmap, and select ‘Blank Map’ under ‘My Templates’ when the program opens
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ii. Click the ‘File’ Menu, Select ‘Save As…’ and type a file name [I will call it ‘Demo.mxd’], and save the document to the SAME directory as your unzipped Shapefile from above

b. Load download ZCTA Shapefile into the map document

i. Ensure the Catalog window is open by clicking the ‘Windows’ menu within ArcMap, then select ‘Catalog’
ii. Ensure the Table of Contents window is open by clicking the ‘Windows’ menu, then select ‘Table of Contents’
iii. Expand the folder that contains the name of the extracted ZCTA file as shown below
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iv. Drag the item that ends with the .shp into the ‘Table of Contents’ window
v. Use the Zoom and Pan buttons in the upper left toolbar to navigate the map to your State of Interest
[image: ]
vi. Save the map by clicking the ‘File’ menu, then ‘Save’.  Your window should appear similar to below (with exception to the colors and zoomed in area)
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c. Load the Aggregated HMIS data into the Desktop GIS

i. Copy the Excel file containing the aggregated HMIS data into the SAME directory as your new map document and your extracted ZCTA Shapefile
ii. In the Catalog window to the right, right-click the directory name at the top containing the word ‘Home –‘ and select Refresh.  You will see your newly copied Excel file.
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iii. Expand the Excel file listed in the Catalog window
iv. Underneath your expanded Excel document, drag the name of the Tab containing the prepared HMIS data to the Table of Contents window [AGOTable in my case]

d. Join the loaded aggregated HMIS data to the ZCTA Shapefile data
i. Open the attribute table of the Loaded in ZCTA Shapefile by right clicking the name of the Shapefile in the Table of Contents Menu, and select ‘Open Attribute Table’
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ii. Find and note the name of the field containing the 5 digit zip codes, it should called ‘ZCTA5CE10’ or similar
iii. Close the Attribute Table by clicking the ‘X’ in the top-right corner of the attribute table
iv. Right-click the ZCTA Shapefile name again, and select ‘Joins and Relates’ / ‘Join’

[image: ]

v. Select the field noted form step ii under item 1 in the dialog box labelled “Chose the field in this layer that the join will be based on:”  [ZCTA5CE10 in this case]
vi. Ensure the appropriate table is selected that contains the aggregated HMIS data under item 2 in the dialog box labelled “Choose the table to join to this layer, or load the table from disk:” [AGOTable$ in this case]
vii. Select the field containing the Zip Codes from the HMIS data under item 3 in the dialog box labelled “Choose the field in the table to base the join on:”  [ZipCode in this case]
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viii. Ensure ‘Keep only matching records’ is selected
ix. Click OK

e. Save results to a new ‘ShapeFile’.  It is necessary to create a new Shapefile with the joined information as the recently completed join is only executed in memory

i. Right click the name of the ZCTA Shapefile that the data was recently joined to and select ‘Data / Export Data’
ii. Ensure ‘All features’ is selected after the word ‘Export’
iii. Ensure ‘this layer’s source data’ is selected under the words ‘Use the same coordinate systems as’
iv. Click the folder icon by the words ‘Output feature class’
v. Navigate to the same directory as your recently copied Excel file with the aggregated HMIS data
vi. Select ‘Shapefile’ under the ‘Save as type’
vii. Name it as appropriate [HMISJoinedData.shp in this case]
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viii. Click Save then OK
ix. Click YES when prompted to add the exported data to the map as a layer
x. Right click the name of the original ZCTA Shapefile in the Table of Contents menu and select ‘Remove’
xi. Save the current map document by the ‘File/Save’ menu

f. OPTIONAL: Find census data for each ZCTA that can be joined using the steps above.
NOTE: this step would allow you to download additional information from the Census Bureau site, such as household information, median income, etc. for each of the ZCTA boundaries. 

i. Open http://www.census.gov in any web browser
ii. Click the ‘Data’ tab, then select ‘Data Tools and Apps’, then select ‘American Factfinder’
iii. Click the ‘Advanced Search’, then select ‘SHOW ME ALL’
iv. Select the ‘Geographies’ link and ensure the ‘List’ tab is showing
v. Click the drop down arrow next to ‘select a geographic type’ and ‘5 Digit Zip Code Tabulation Area’
vi. Select the desired State under the ‘Select a state’ label.
vii. Click the ‘All 5-Digit Zip Code Tabulation Areas’ selection and select the ‘ADD TO YOUR SELECTIONS’ button
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viii. Close the current window
ix. Select the checkbox next to the desired characteristics you wish to download for each Zip Code Tabulation Area [Households and Families] in this case
x. Click the ‘Download’ link and Save to your computer
xi. Extract the zip file contents and open the .csv that ends in the title ‘_with_ann.csv’. 
xii. Delete the first row of headers, rename ALL the second row headers to one word names and deleted the undesired columns of data. 
xiii. Note the name of the Zip Cope field [Id2 in this case] as this will be the field that is used in the join process
xiv. Follow the steps D and E above to join this data and save as a new Shapefile

3. Prepare appropriate visualizations

a. Example A: Create a thematic map of total client counts for each zip code

i. Right-click the name of the layer containing the joined data [HMISJoinedData in this case]
ii. Select ‘Properties’ then click the ‘Symbology’ tab
iii. On the left side of the window under ‘Show’, select the ‘Quantities’ heading and ensure that the ‘Graduated Colors’ heading is selected
iv. Under the ‘Fields’ heading, click the drop down box next to the ‘Value’ label and select the column that contains a total count for each Zip Code [Total in this case]
v. Under the ‘Classification’ heading, select the button labelled ‘Classify…’
vi. At this point the user can select from a variety of classification methods and number of breaks.  This topic alone deserves a great deal of focus, but for the sake of demonstration, we will select manual breaks.  See the Desktop help for a good description of each of the classification methods
vii. Click OK when finished with the classification methods
viii. If it is desired to format the labels, right click any of the classifications under the ‘Symbol’ label and select ‘Format Labels’.  Then format as desired.  When complete your symbology tab may appear as below
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ix. Click OK when complete and zoom in to your area of interest
x. Save the current map document by the ‘File/Save’ menu.

b. Example B: Create a dot-density map representing vet and non-vet counts for each zip code

i. Right-click the name of the layer containing the joined data [HMISJoinedData in this case]
ii. Select ‘Properties’ then click the ‘Symbology’ tab
iii. On the left side of the window under ‘Show’, select the ‘Quantities’ heading and ensure that the ‘Dot density’ heading is selected
iv. Under the ‘Field Selection’ label, double click the two fields representing the vet and not vet counts for each zip code [Vet and NotVet in this case]
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v. Double click the Symbol next to each category selected above and select a unique color that will stand apart from the other [in this case I will select Red for Vet and Black for NotVet]
vi. Uncheck the checkbox labelled ‘Maintain Density By’ in order to persevere your density setting (how many people each dot actually represents)
vii. Change the ‘Dot Value’ to 1 in order to create a 1 for 1 representation (each HMIS client will be represented by 1 dot on the map).  Or, set the value as desired
viii. Save the current map document by the ‘File/Save’ menu



[bookmark: _Toc432586528]Appendix D - Online GIS Workflow

This appendix shows the appropriate steps to take aggregated HMIS data and create visualizations within an Online GIS (ArcGIS Online).  It will cover the techniques to create the online maps, which can serve as the basis for presenting the maps in a variety of manners (story maps, web application, etc.)

Prerequisites:
· Aggregated HMIS data at the zip code level
· Excel 2010 or Higher
· An ArcGIS Organizational/Developer Account
· ESRI Maps for Office Installed (requires ArcGIS Organizational/Developer Account)

Online GIS Steps Overview
1. Publish the aggregated HMIS data to an Online Service
2. Create and Configure an Online Map consuming the service
3. Create front-end applications (web app, web template, story map, etc.)

Online GIS Steps Details
1. Publish the aggregated HMIS data to an Online Service

a. Open the prepared Excel table containing the aggregated HMIS data at the Zip Code level
b. Click within the table, and click the tab in the Excel ribbon labelled ‘Design’
c. On the far left, remember the name of the current table.  You can also rename it to a more appropriate one if desired.  
[image: ]
d. Ensure the Excel Ribbon contains a tab labelled ‘ESRI Maps’.  If not, you need to install ESRI Maps for Office (see the link under the prerequisites section above)
e. Select the ESRI Maps tab in the Excel Ribbon and click the button labelled ‘Sign In.
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f. Enter your credentials for your ArcGIS Organizational or Developer account and sign in
g. Click the button in the same ribbon tab labelled ‘Add Map’
h. Under item 1 labelled ‘Data’, select the name of the table noted above
i. Under item 2 labelled ‘Location Type’, select ‘ZIP Codes’
j. Next, select the name of the column containing ZIP Code information [ZipCode in this case] and select to OK
k. Under item 3 labelled ‘Style by Column’ select the field that you would like to be mapped [In this case, I am selecting the Total Column which will thematically map total clients per each zip code]
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l. Select a desired style color then click the button labelled ‘Add data’
m. Select the bottom option labelled ‘Do not aggregate areas’ as we have already done so in previous tutorials.
NOTE: It is possible to perform the aggregation at this step, but at the time of writing the tutorial, this wizard did not allow for aggregating only on ‘Distinct Counts’ which may be necessary depending on the data source

[image: ]
n. Finally click the ‘Add Data’ Button to create an inline map inside of Excel
NOTE: It is possible to use and configure this as your final map, however, we will follow additional steps to publish the data to an online source which will allow for later services such as web maps, web applications, and story maps.
o. In the resulting in-line map, click the ‘Share Layer’ button and enter an appropriate Title,  Tags and Summary
p. Click the ‘Share’ Button
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q. Save the Excel document using the File/Save menu.

2. Create and Configure an Online Map and add the appropriate map layer (i.e. service)
NOTE: There are numerous settings and configurations that can be applied to a web map.  This tutorial will walk through just a few of the basic steps such as creating the map and adding a layer, setting the style of that layer, and configuring a pop-up for that layer.  

a. Create the online map 
i. Log in to your ArcGIS Online Organization using the same credentials from the steps above.
ii. Click the link titled My Content
iii. Click the Create item, then select Map
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iv. Enter an Appropriate Title, Tags, and Summary, then click OK
v. Click Add, then select ‘Search for Layers’
[image: ]
vi. Under the ‘Search for Layers’ panel, select ‘My Content’ for the in field
vii. Scroll to the recently added layer that was published from Excel and click ‘Add’
viii. Click ‘Done adding layers’.   Note that additional layers from any source (web, published from Excel, etc.) can be added in this manner
ix. Zoom into the desired focus area of the map using the map + and – options

b. Configure the style of the HMIS data

i. In the Contents menu underneath the newly added layer, hover over the buttons to see pop-ups and select the option to ‘Change Style’, which is the circle, square, and triangle button
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ii. Under item 1, ‘Choose and attribute to show’, ensure that the appropriate field is selected to display [Total in this case]
iii. Under item 2, ‘Select a drawing style’, select ‘Options’ under Counts and Amounts (Color)
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iv. At this point you can select a variety of style classifications (manual breaks, quantile, equal interval, etc.), but in this case we will keep the defaults.  See this tutorial for more information
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v. Click OK, then click Done

c. Configure the map popup for the HMIS Data

i. In the Contents menu underneath the newly added layer, hover over the buttons to see tool tips and select the option for ‘More Options’, which is the three periods together
ii. Click configure popup
iii. At this point a variety of custom popups can be created for when users click on a single zip code.  Additionally, custom charts can be created (such as a pie chart showing race quantities) to be shown as a user clicks on each zip code.  See this tutorial for more information

[image: ]

iv. Finally ,click the ‘Save pop-up’ button

d. Save the map by clicking the Disk icon

3. Create front-end applications (web app, web template, story map, etc.)

NOTE: Now that a web map has been created there are several front end applications that can be developed for presenting your map on a variety of devices (mobile phones, tablets, PCs, etc.)  Listed below are tutorials for creating 3 of the primary front-end applications that can present the online map that we just recently created.

a. Create an app from Web Templates
b. Create an app from Web App Builder
c. Create a Story Map




[bookmark: _Toc432586529]Appendix E - ESRI Software Options

This appendix was produced from an email that was sent to the Pathways Research team describing options for obtaining the software that was used in the GIS project.   

The GIS web interactions that I have been demonstrating recently are using ESRI's ArcGIS Online platform.  There are other GIS systems that can view/host GIS data, but it is the PLATFORM that has enabled me to build the demo sites and applications very quickly.  I also believe this platform, with their latest push to 'web GIS' will better enable non-GIS persons to create similar applications as well.  Additionally, when working with local governments, I think there is a VERY high probability that they will be using the same platform.  Keep in mind most GIS file types (Shapefiles [.shp], KML, etc.) are somewhat interchangeable between most GIS platforms, but the applications you build to host/consume those (i.e. web applications) likely will NOT be.
 
With that said, outside of hosting your own ArcGIS server (which is still somewhat costly even with a non-profit license and will also require some expertise), the best option of using ESRI's Online platform is through what are called ArcGIS online organizational accounts.  These accounts give you named user logins to access Web GIS data, maps, and applications (such as story maps) and allow you to restrict data to specific users if desired.  From my viewpoint, the options below are some of the better ways to pursue this route for Pathways if desired: 
 
1. Developer Account [free, developer only, single account]: continue using the pathDev account I set up and used to demonstrate the original Atlanta CoC online data.  It is private data that is accessible only by one user.  Also, this site is for development only.  However, I believe if the data you are publishing can be made public (viewable by anyone) then you might can get by with only this type of account.  This statement is from the ESRI FAQ site regarding this type of account: “You can also use this plan to build apps for public, non-revenue generating, non-government, non-commercial use”
 
1. Penn State Accounts [free, two accounts, temporary]: I've managed to acquire two accounts through Penn State's ArcGIS online accounts.  One is for me, and the other would be to share with the end user (Coc).  I plan to use these accounts to create and share the Cobb County data that we are working on.  I don't believe these accounts will terminate immediately after my project ends, but they would not be a permanent solution.
 
1. Pathways Desktop Non-profit account [$100 annual, one online account (and desktop) ]:  if you get accepted to the non-profit desktop program at ESRI (I believe it is likely that you would be), then you will also get a single-user online account as well.  This would be similar to the Developer account, but also includes a desktop license(which is normally SIGFICANTLY HIGHER).  Again, it is for a single user only and would probably be the best option if all of the maps you are creating can be made public
 
1. Atlanta Regional Commission GIS group online accounts [free?, multiple accounts?, owned by ARC].  It is possible that the ARC GIS team (via David G.) may have some online accounts available through their enterprise license.  If you worked something out, I would suggest obtaining 4-5 accounts if possible.  One would be for pathways, and the rest for individual CoCs.  With separate accounts, you can easily specify which account has access to which data/application.  If the maps you are producing need to be private AND shared with others, then this would be the best option.
 
1. HUD online accounts [free?, multiple accounts?, owned by HUD, unlikely possibility?]- I noticed that HUD is also using the ESRI platform. They are likely to have a similar (or better) enterprise agreement with ESRI and may also have accounts that can be shared.  This would be the same setup as #4, but probably a lot less likely.  If you have any HUD contacts in their GIS department, this might be worth pursuing.  
 
1. Pathways Online Non-profit [$1250 annual, 5 online licenses, costly] - ESRI also has a discounted multi-user online program, but as you can see it can be costly, even for non-profits.  Unless GIS will be a MAJOR factor for pathways, then this option is probably too costly.
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